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1 Introduction

PSoC has powerful and flexible general-purpose 1/0 (GPIO) pins that provide more features than traditional MCUs. In
PSoC, the GPIOs are controlled not only by configuring the registers in the firmware, similar to traditional MCUs, but
are also driven by custom digital logic and analog block signals. This application note explains the basics of PSoC 4
GPIO pins and demonstrates techniques for using them effectively for different functions.

This application note assumes that you are familiar with PSoC Creator™ and the PSoC 4 architecture. If you are new
to PSoC 4, read AN79953 — Getting Started with PSoC 4. If you are new to PSoC Creator, visit the PSoC Creator
home page. For information on device packages or GPIO specifications, see the PSoC 4 datasheet. If you already
know the PSoC 4 device and the PSoC Creator, you can jump to the section GPIO Tips and Tricks.
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PSoC Resources

Cypress provides a wealth of data at www.cypress.com to help you to select the right PSoC device for your design,
and to help you to quickly and effectively integrate the device into your design. For a comprehensive list of resources,
see KBA86521, How to Design with PSoC 3, PSoC 4, and PSoC 5LP. The following is an abbreviated list for
PSoC 4:

Overview: PSoC Portfolio, PSoC Roadmap

Product Selectors: PSoC1, PSoC 3,
PSoC 4, or PSoC 5LP. In addition, PSoC
Creator includes a device selection tool.

Datasheets describe and provide electrical
specifications for the PSoC 4000,
PSoC 4100, and PSoC 4200, PSoC 4xx7
BLE, PSoC 4200-M, PSoC 4200-L device
families

CapSense Design Guide: Learn how to
design capacitive touch-sensing applications
with the PSoC 4 family of devices.

Application Notes and Code Examples
cover a broad range of topics, from basic to
advanced level. Many of the application
notes include code examples. PSoC Creator
provides additional code examples — see
Code Examples.

Technical Reference Manuals (TRM)
provide detailed descriptions of the
architecture and registers in each PSoC 4
device family.

Development Kits:

o CY8CKIT-040, CY8CKIT-042, CY8CKIT-
042-BLE, CY8CKIT-044 and CYB8CKIT-
046 PSoC 4 Pioneer Kits are easy-to-use
and inexpensive development platforms.
These kits include connectors for
Arduino™  compatible shields and
Digilent® Pmod™ daughter cards.

o CY8CKIT-049 is a very low-cost
prototyping platform for sampling PSoC 4
devices.

o CY8CKIT-001 is a common development
platform for all PSoC family devices.

The MiniProg3 device provides an interface
for flash programming and debug.
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PSoC Creator

PSoC Creator is a free Windows-based Integrated Design Environment (IDE). It enables concurrent hardware and
firmware design of systems based on PSoC 3, PSoC 4, and PSoC 5LP. See Figure 1 —with PSoC Creator, you can:

1.

workspace

PSoC hardware

Drag and drop Components to build your
hardware system design in the main design

Codesign your application firmware with the

5.

Review Component datasheets

Figure 1. PSoC Creator Features

3. Configure Components using configuration tools

4. Explore the library of 100+ Components
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Figure 2. Code Examples in PSoC
Creator

PSoC Creator includes a large number of example projects. _/m (

These projects are available from the PSoC Creator Start Page,
as Figure 2 shows.

AN

Example Projects

PSoC® Creator™

Example projects can speed up your design process by starting
you off with a complete design, instead of a blank page. The
example projects also show how you can use PSoC Creator
Components for various applications. Example projects and Recent Projects .
datasheets are included, as Figure 3 shows. Create New Project...

Open Bxisting Project ...

In the Find Example Project dialog shown in Figure 3, you have
several options:

Getting Started

m  Filter for examples based on architecture or device family gs?i?f?g ’,3:'“ Page

(such as PSoC 3, PSoC 4, or PSoC5LP); category; or Irr::to PE'SDCL" &

keyword Intro to PSolC Creator

PSaoC Creator Trainin

m  Select from the menu of examples offered based on the Design Tutorials ¢

Filter Options Getting Started With PSoC 3 E

. i Getting Started With PSoC 4

m  Review the datasheet for the selection (on the Getting Started With PSoC 5LP

Documentation tab)
Examples and Kits

m  Review the code example for the selection. You can copy Find Example Projsct
and paste code from this window to your project, which can Kits
help speed up code development, or Product Information
m  Create a new project (and a new workspace, if needed) PSoC. Creator
based on the selection. This can speed up your design Egzg gmgmmmer
process by starting you off with a complete, basic design. PSoC 4 | 4

You can then adapt that design to your application.

Figure 3. Example Projects with Sample Code

Find Example Project @

Fitter Options

l Documentation ./ Sample Code .B] I 4 b
Architecturs [Psoc 4 | | S~ ’ =1
Device Family: [ﬂ.l.l v] £

/* Enable glcbal interrupts */
Category PSLC 4100 CyGlobalIntEnable;
PSoC 4200
Keyword /* Start PWM and CapSense components */
LED_CONTROL Start();

Project Name )
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Bootloadzble_PSoC4_Example |
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apSense C5D P4 Desig
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CharlCO_CustomFort /* Update all baselines */
g?r{;glgtst‘_‘g;éocd_&amp\e 1 CapSense_ CSD_UpdateEnabledBaselines();
Court7_Example
CRCExample /* Start scanning all enabled sensorsz */
C5D_Comp_AMLUX CapSense CSD ScanEnabledWidgets():
DebouncerExample - -
Em_EEPROM_Example
Fan_Control_Auta_FW _with_Alert /* Wait for scanning to complete */
FW_Fan_Control while (CapSense_CSD_IsBusy() != 0):
GlitchFilterBxample - -
Hibemate_and_Stop_PowerModes . R ~
Hibemate_P SoC4_BExample /* Display CapSense state using LEDs */
[2C_LCD_Bxample_PSoC4 CapSense DisplayState(): A
IDACSE_PSoC4_Example i J i = | »
WA T Al

’ Add to Existing Workspace ] [ Create New Workspace ] I Cancel
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PSoC Creator Help

Visit the PSoC Creator home page to download the latest version of PSoC Creator. Then, launch PSoC Creator and
navigate to the following items:

Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you the basics for
developing PSoC Creator projects.

Simple Component example projects: Choose File > Open > Example projects. These example projects
demonstrate how to configure and use PSoC Creator Components.

Starter designs: Choose File > New > Project > PSoC 4 Starter Designs. These starter designs demonstrate
the unique features of PSoC 4.

System Reference Guide: Choose Help > System Reference > System Reference Guide. This guide lists
and describes the system functions provided by PSoC Creator.

Component datasheets: Right-click a component and select “Open Datasheet.” Visit the PSoC 4 Component
Datasheets page for a list of all PSoC 4 Component datasheets.

Document Manager: PSoC Creator provides a document manager to help you to easily find and review
document resources. To open the document manager, choose the menu item Help > Document Manager.

6 Technical Support

If you have any questions, our technical support team is happy to assist you. You can create a support request on the
Cypress Technical Support page.

If you are in the United States, you can talk to our technical support team by calling our toll-free number: +1-800-541-
4736. Select option 8 at the prompt.

You can also use the following support resources if you need quick assistance.

Self-help

Local Sales Office Locations
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GPIO Pin Basics

The PSoC 4 GPIO pins offer the following features:

®  Analog and digital input and output capability

m  LCD segment drive support (not available in PSoC 4000)
m CapSense® support

= Interrupt on level, rising-edge, falling-edge, or both edges
m  Slew-rate control

m  |nput threshold select (CMOS / LVTTL / 1.8-V CMOS)

= Overvoltage-tolerant pins (available only in PSoC 4 BLE, PSoC 4 M-Series and PSoC 4 L- Series) with hot swap
capability

7.1 Physical Structure of GPIO Pins
Figure 4 shows the pin connections with the resources in the PSoC 4 device.

Figure 4. Simplified GPIO Block Diagram

Buffer
Digital
Input
Digital Digital Output i
Output 7 Driver X Pin
Analog

A detailed block diagram of the GPIO structure is available in the “I/O System” chapter of the PSoC 4 Architecture
TRM. Each pin can act as an input or an output to the CPU and the digital peripheral such as the Timer, PWM, or I°C.
It can also act as an analog pin for use with opamps and ADC. At any given time, you can use a pin for only digital
input, or only digital output, or only analog pin, or even combinations of these three. For example, if you enable both
the digital output and the input, it provides a digital bidirectional pin. The input buffer provides high-impedance to the
external input. It is configurable to the following signaling standards:

= CMOS
m LVTTL

m  1.8-V CMOS (available only in PSoC 4 BLE, PSoC 4 M-Series and PSoC 4 L-Series)
For the input threshold values, see the device datasheet.
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The digital output driver supports different drive modes and slew-rate control (see Figure 5).

Figure 5. Digital Output Driver

Vdd vdd

Digital
Logic

Slew
Control

— | Output
Enable

> Drive
Mode

Slew-rate control is provided to reduce EMI and cross-talk. There are two options — Fast and Slow. Slew rate is set to
Fast by default. Use the Slow option when the signals are not speed-critical.

The circuit shown in Figure 5 supports eight drive modes in PSoC 4, as listed in Table 1.

Table 1. Drive Modes and Applications

# Drive Mode Application Examples

1 High-impedance Analog Analog input/output

2 High-impedance Digital Digital input

3 Resistive Pull-Up (~5 kQ) Interface to open drain-low input, such as tachometer output from motors or a switch
connected to ground. It can also be used to drive LEDs.

4 Resistive Pull-Down (~5 kQ) Interface to an open drain-high input or a switch connected to VDD. It can be used as
an output to interface LEDs in current sink mode.

5 Open Drain, Drives Low Provides high-impedance in the high state and a strong drive in the low state; This
configuration is used for I’c pins. This mode works in conjunction with an external pull-
up resistor.

6 Open Drain, Drives High Provides strong drive in the high state and high-impedance in the low state. This mode
works in conjunction with an external pull-down resistor.

7 Strong Drive CMOS output drive in both low and high state

8 Resistive Pull-Up and Adds series resistor in both high and low states

Resistive Pull-Down (~5 kQ)
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Figure 6. Drive Modes

Pin

Out

Analog

Out

Analog

In pd
~

VDD

Out >o ~5k
Pin

Analog

VDD

"“—t%*{%

Analog

1. High-Impedance
Analog

2. High-Impedance
Digital

3. Resistive Pull Up

4 Resistive Pull Down

VDD
u}_ In <I
VDD
~5k
) 0 1>c .
In P Pin VDD |I’:J M Pin
~ ~
Out Pin
I> ~5k
Analog Analog Pin Analog Analog 4’(
5. Open Drain 6. Open Drain 7. Strong Drive 8. Resistive Pull Up
Drives Low Drives High & Pull Down

Note 1: The resistor values for the pull-up and pull-down drive modes, shown in Figure 6, are approximate values;
see the device datasheet for the resistor value specifications. Use an external resistor if higher accuracy is required.

In this case, the pin must be configured as open drain drive high or open drain drive low.
Note 2: At all times, avoid the device VDD getting powered from an external voltage at the pin through the ESD

clamp diodes. This can happen if the PSoC 4 device is not powered and an external voltage is applied at the GPIO or
when an external voltage at the GPIO is greater than the device VDD. This is, however, not applicable to the

Overvoltage-Tolerant (OVT) Pins as there are no clamp diodes.
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7.2 Pin Routing

7.2.1 Digital Routing

A pin can be routed to different digital peripherals, such as the universal digital block (UDB), serial communication
block (SCB), timer/counter/pulse-width modulator (TCPWM) block, LCD driver, CAN block, interrupt controller, and
the data register which is read/iwritten by the CPU. Figure 7 shows the routing for an input pin and Figure 8 shows the
routing for an output pin.

As shown in Figure 7 and Figure 8, peripherals are connected to the pins using the high-speed I/O matrix (HSIOM). It
multiplexes the signals from different peripherals to connect to a particular pin.

In PSoC 4, there are two routing possibilities: dedicated I/O routed through the HSIOM and flexible routing using
digital system interconnect (DSI). DSI usage is not limited to routing the peripheral inputs and outputs to pins; it is
also used to route signals between digital resources. The Port Adapter connects the HSIOM and the DSI. It also
provides hardware to synchronize pin input and output signals.

Figure 7. Digital Pin Input Path

> CANe@)
> SCB
HSIOM " TCPWM
From Input — ) .
Buffer Snghd
pee
0 1> PO DSl UDB()
Matrix P
I
—_— Interrupt
GPIO Edge N Controller
Detect
N CPU
(Pin State Reg)

1. not applicable to PSoC 4000
2. not applicable to PSoC 4000, PSoC 4100, PSoC 41xx-BL and PSoC 4100M
3. only available in PSoC 4200M and PSoC 4200L

SCB (°C, UART, and SPI) and TCPWM have dedicated routes to some I/Os. The flexible routing option is available
for UDB inputs and outputs, generating interrupts from the pins, and even for TCPWM. The LCD driver is present in
all I/0Os of the PSoC 4 parts (except PSoC 4000), with any 1/O acting as a segment or a common driver for the LCD
glass.

The GPIO Edge Detect block enables pin interrupts on rising-edge, falling-edge, and both edges. See the GPIO
Interrupt section for details.

WWW.Cypress.com Document No. 001-86439 Rev.*C 9


http://www.cypress.com/

PSoC® 4 — Using GPIO Pins

Figure 8. Digital Pin Output Path

CANg@) >
SCB >
» HSIOM
TCPWM > High To Digital
Port Speed L Output
DSl@) [ > 1o Driver
Adapter) Matrix
UDB(2) >
LCD@) >
CPU .
(Data Reg) "

1. not applicable to PSoC 4000
2. not applicable to PSoC 4000, PSoC 4100, PSoC 41xx-BL and PSoC 4100M
3. only available in PSoC 4200M and PSoC 4200L

Note: PSoC 4 has multiple ports with a maximum of 8 pins per port. For PSoC 4200L devices Port 7 to Port 10 pins
do not have the port adapter and for other devices Port 4 and higher ports do not have the port adapter. These ports
have the following restrictions:

m  Cannot be routed through the DSI; thus UDB-based digital signals cannot be routed to the pins of these ports

m  Cannot be used for analog blocks, such as SAR ADC, Opamp - Continuous Time Block mini (CTBm), and Low-
Power Comparator (applicable only to PSoC 4100 and PSoC 4200)

= No input/output synchronization
However, these ports are useful in the following ways:

m  As a GPIO controlled in firmware
m  Direct connection to TCPWM, SCB, or CAN
m  LCD and CapSense pins

m  Interrupts generation

Note: Pins of the PSoC 4 device are shared for dedicated connections to different peripherals. To know the functions
possible at each pin, see the “Pinouts” section in the respective device datasheets.
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Analog Routing

GPIO pins configured in the High-Impedance Analog (HI-Z) mode are connected to the analog resources by direct
connections or through the analog switches and the analog mux (AMUX) bus, as Figure 9 to Figure 12 show.

Following are the key highlights of the analog routing in the PSoC 4000 parts shown in Figure 9:

m  All pins (except port 3) can connect to the AMUX buses, controlled by firmware. There are two buses:
AMUXBUS_A and AMUXBUS_B.

m  CapSense IDACO is connected to AMUXBUS_A, and IDAC1 is connected to AMUXBUS_B.
m  CapSense CMOD is connected to PO[4], and the shield tank capacitor is connected to PO[2].

m  Any pin can be used for the capacitive touch sensors (except Port 3) as the CapSense block connects to the
sensors using the AMUX bus.

Note: Place the CMOD capacitor close to the pin. See AN85951 PSoC 4 CapSense Design Guide for layout
guidelines.

Following are the key highlights of the analog routing in other PSoC 4 parts, as shown in Figure 10, Figure 11, Figure
12 and Figure 13:

m  There are two AMUX buses. All pins have the capability to connect to AMUXBUS_A and AMUXBUS_B. AMUX
bus connection can be controlled by firmware or using the DSI signal. Note that in case of port 4 and higher port
pins, where the DSI connection is not available, AMUX can be connected only in firmware.

m  Direct connections are available for opamp inputs and outputs, which provide better performance due to lower
trace resistance and parasitic capacitance.

m  Direct connections are also available for low-power comparator (LPCOMP) inputs without switches.

m  There are dedicated pins for CapSense CMOD and the shield tank capacitor. See Figure 10, Figure 11, Figure
12, and Figure 13 to know the pins.

m  CapSense IDACO is connected to AMUXBUS_A, and IDAC1 is connected to AMUXBUS_B.

®  Any pin can be used for the capacitive touch sensors as the CapSense block connects to the sensors using the
AMUX bus.

= AMUXBUS_A and AMUXBUS_B can be split using switches (marked in blue) as shown in Figure 11, Figure 12
and Figure 13. This is useful in case the AMUX buses are required for non-CapSense applications, such as
opamp/comparator input and output routing, along with the CapSense in the system.

m  The SAR sequencer connects the SAR ADC input to:

o Port 2 in PSoC 4100 / PSoC 4200, PSoC 4100M / PSoC 4200M and PSoC 4200L and Port 3 in
PSoC 41xx-BL / PSoC 42xx-BL

o CTBm outputs

o Temperature sensor output.

Multiplexing is done by controlling the switches shown in red in Figure 10, Figure 11, Figure 12, and Figure 13. Note
that the SAR ADC can also take the input from any pin using AMUXBUS without the sequencer.

Note: The opamp output is connected to a dedicated pin without any switches. If the connection to AMUX bus is
required, the AMUX switch associated with the dedicated pin is activated. This also allows other pins to act as opamp
output pins if the corresponding AMUX switches are activated.

Note: When the SAR ADC is operated with differential inputs in the sequencer mode, the positive input can only be
an even pin with negative input as the adjacent odd pin. For example, in PSoC 4200, P2[0] and P2[1] are pair pins
with P2[0] as positive input and P2[1] as negative input.
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Figure 9. PSoC 4000 Analog Routing Diagram
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PO[0], PO[1], PO[2] and POI[3] are directly
connected to LPCOMPO and LPCOMP1

Figure 10. PSoC 4200/PSoC 4100 Analog Routing Diagram
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CTBm /

Figure 11. PSoC 41xx-BL/PSoC 42xx-BL Analog Routing Diagram

P2[2] and P2[3] are
connected to OAO and
OA1 OPAMP outputs
respectively

P1[2] and P1[3] are
connected to OA2 and
OA3 OPAMP outputs
respectively

A ~Ir]
Q=0
AMUXBUS B RAAIAIAID 4D (b 4Ibdi
s OHO? OO
trcomp ||
A A §P0[7]
LPCOMP1 {00t Po[6]
vminus @@t <Po[5]
vplus @@+ <Po[4]
o< Po3]
LPCOMPO @-01<P0[2]
vminus [;; E PO[1]
i vplus Ic POI[0]
B L [0]
O O
O O
Py sarbus0 Py
pdhd sarbus1 hd
+ - -+ + - -+
OA1 OAO0 OA3 OA2
VYN /N VAVAR: 7
Comp ot to DSI Comp out to DSI Comp ot to DSI Comp out to DSI
— CAPSENSE
temp .
SAR Vssa_kelvin a o Switch Control Legend
8 %’ % O Firmware Only
SARADCO . 819 _ 13 3 @ Firmware + DSI
vplus D 2 |~ =]
P B ]l S o &} P = 5 @ Firmware + DSI + SAR-Sequencer
vminus @ AMUX Splitter - Firmware Only
ext_vref —

EEY
oled
ed
ed
ed
ed
ed
€d
ed

PO[0], PO[1], PO[4] and
PO[5] are connected to
LPCOMPO and
LPCOMP1 inputs

WWW.Cypress.com

Document No. 001-86439 Rev.*C

14


http://www.cypress.com/

=¢ CYPRESS

PERFORM °
PSoC"™ 4 — Using GPIO Pins

Figure 12. PSoC 4100M/PSoC 4200M Analog Routing Diagram
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Figure 13. PSoC 4200L Analog Routing Diagram
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Note: The PSoC Creator IDE tool provides an analog routing diagram for a design similar to those illustrated in
Figure 9 to Figure 12. See the Analog tab in the .cydwr file of the project in PSoC Creator.
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Startup and Low-Power Behavior

On reset/power-up, all GPIO pins start up in the high-impedance analog mode, that is, with input buffer and output
driver disabled. These GPIO pins remain in this mode until the reset is released; then the initial operating
configuration of associated registers of each GPIO pin is loaded during boot and takes effect at that time. During run
time, GPIOs can be configured by writing to associated registers.

Note: In the PSoC 4000 parts (all parts except the 24-pin QFN), pin P1[6] is temporarily configured as XRES during
power-up until the device executes the start-up code. Do not pull this pin down during power-up as this keeps the
device in reset.

See KBA91258 — I/O System Restrictions in the PSoC 4000 Family for more information.

PSoC 4 has four power modes. Table 2 shows the power mode availability in the PSoC 4 families.

Table 2. Low Power Modes

Device Sleep Deep Sleep Hibernate Stop
PSoC 4000 v v x x
PSoC 4100/4200 v v
PSoC 4 BLE v v v v
PSoC 4 M v v v v
PSoC4L v v v v

In the Sleep mode, the GPIOs are active and can be actively driven by the peripherals. Only the CPU is inactive in
this mode. In the Deep-Sleep mode, the pins driven by the deep-sleep sources such as I’C, LCD driver, opamp, and
comparator are functional. The l’c pins can wake the device up on an address match event. The segment LCD,
connected to the device pins, is periodically refreshed even in the Deep Sleep mode.

The PSoC 4 parts (except PSoC 4000) have an additional feature that freezes the GPIOs in Deep-Sleep, Hibernate,
and Stop mode. Unfreezing of GPIOs also happens automatically when the low power mode is exited. However, note
that the GPIOs driven by Deep-Sleep peripherals are active in Deep-Sleep mode and are not frozen.

In the case of Hibernate and Stop mode, wake up happens with a device reset. This clears the GPIO configuration
and the state. To retain the pin state, use the CySysPmFreezeIo() and CySysPmUnfreezeIo () APIs. Note that
you do not need to call the CySysPmFreezeIo ()function for Stop mode since it is automatically called when the
user invokes Stop mode using the APl CySysPmStop(). However, you should call the CySysPmFreezeIo () API
just before the function call to enter the Hibernate mode. The GPIOs are unlocked with the call to API
CySysPmUnfreezeIo (). Callto this APIis also required when the exit is made from the Stop mode. Note that the
Frozen pin states and configurations are not maintained on an external reset (XRES) event.

CySysPmFreezelIo () and CySysPmUnfreezelIo () are also useful in Deep-Sleep mode. An example of use of this
feature is shown in the Control Register Handling in Deep-Sleep section. The UDB-based components, such as the
control registers, are not active and lose the data in Deep Sleep, Hibernate, and Stop modes. If the Control Register
is driving a pin, a glitch can occur when the PSoC device enters or exits these modes if the last state is ‘1’. To avoid
this glitch, the GPIO should be frozen before entering the low-power mode.

For information on the low-power modes, see AN86233 — PSoC 4 Low-Power Modes and Power Reduction
Techniques.
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7.4 GPIO Interrupt
Figure 14 shows the detailed diagram on the signal path from HSIOM to the Interrupt Controller.

Figure 14. GPIO Interrupt Signal Routing
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(a) Not available in PSoC 4000

At each of the 32 interrupt lines of the Interrupt Controller in the processor core, there is an “Interrupt Source
Multiplexer”. This multiplexer block selects the source of interrupt and provides an option of rising-edge detection or
the direct connection to the Interrupt Controller. There are two sources of interrupts-

1. Fixed Function Source
2. DSI Source

The “Interrupt Select” line selects the DSI or the fixed function source. The “Interrupt Configuration” selects the direct
connection or the rising-edge detection logic route to connect to the Interrupt Controller.

A fixed function interrupt source has a fixed-interrupt vector; this means that the interrupt source has a dedicated
connection to one of the 32 interrupt lines of the Cortex MO. Interrupt source on this route is directly connected to the
Interrupt Controller. When the interrupt source is routed through the DSI, the vector selection is not fixed. This routing
also provides an option of rising-edge detection in addition to the direct connection.

Note: The interrupt vector table is available in the Interrupts chapter of the Technical Reference Manual.

The use of Interrupt Source Multiplexer is not limited to the GPIO interrupts; it is also used for all other sources. To
know more about other interrupt source see the “Interrupt Sources” section of AN90799 - PSoC® 4 Interrupts.

The GPIO interrupt, in addition to the resources present in the Interrupt Source Multiplexer, makes use of its own
GPIO Edge Detect block as Figure 14 shows.

The GPIO interrupt signal from the HSIOM is routed in the following ways:

m  Route 1: Fixed function route through the GPIO Edge Detect block with the Interrupt Source Multiplexer
configured to direct connection

m  Route 2: DSI route through the GPIO Edge Detect block with the Interrupt Source Multiplexer configured to
rising-edge

m  Route 3: DSI route through the GPIO Edge Detect block with the Interrupt Source Multiplexer configured to direct
connection

= Route 4: DSI route bypassing the GPIO Edge Detect block with the Interrupt Source Multiplexer configured to
rising-edge

= Route 5: DSI route bypassing the GPIO Edge Detect block with the Interrupt Source Multiplexer configured to
direct connection

The section Pins Component Interrupts explains how different routes are configured.
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7.4.1

Figure 15 shows the GPIO Edge Detect block. This block detects rising-edge, falling-edge, and both edges in the
incoming GPIO signal. Individual GPIO interrupt signals within a port are ORed together to generate a single interrupt
request. Thus, there is one interrupt vector for each port.

Figure 15. GPIO Edge Detect
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As it is clear from Figure 15, when the interrupt is triggered, the interrupt source is required to be identified. PSoC 4
provides a status register to identify the interrupting pin. After reading the status register, it is important to clear it
whenever the GPIO Edge Detect logic is used to avoid the following behavior:

1. Single interrupt trigger and non-responsive to further interrupts when the Interrupt Source Multiplexer is
configured to rising-edge. This scenario will occur if Route 2 is used.

2. Repetitive interrupts for a single request when the Interrupt Source Multiplexer is configured to direct connection.
This scenario will occur if Route 1 or Route 3 is used.

When the GPIO interrupt takes the route without the GPIO Edge Detect block, there is no need to clear the interrupt.
However, when the rising-edge detection logic in the Interrupt Source Multiplexer is also bypassed, it results in a level
type interrupt (Route 5). In this case, the interrupt is triggered repeatedly as long as the pin signal is high. Thus, it is
recommended to configure the Interrupt Source Multiplexer to a rising-edge interrupt when the GPIO Edge Detect
block is bypassed (Route 4).

Note: The GPIO interrupt logic continues to function in the Sleep, Deep Sleep, and Hibernate modes; thus, any pin
can be used as a wakeup source. A dedicated wakeup pin, PO[7], is available to wake the device from Stop mode in
PSoC 4200 / PSoC 4100, PSoC 4 M and PSoC 4 L parts. For a PSoC 4 BLE device, the wakeup pin is P2[2].

Limitations in GPIO Interrupt

1. Port 4 and higher ports do not have a Port Adapter. Thus, pin interrupt via DSI routing is not possible for these
port pins.

2. PSoC 4000 and PSoC 4100/PSoC 4200 have one interrupt vector for each port. PSoC 4 BLE does not have a
dedicated interrupt vector for the ports beyond Port 5 and PSoC 4 M does not have one for the ports beyond Port
4. However, a common port interrupt vector is allocated, which gets triggered when any port interrupt becomes
active. See the Pins Component datasheet to understand how to use this common port interrupt.

An example project is shown in the Pin Interrupt section, which explains how to use the GPIO interrupt. To
understand interrupts in general, see the application note AN90799 — PSoC 4 Interrupts.
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0o

9.1

Overvoltage-Tolerant (OVT) Pins

Pins P5[0] and P5[1] in PSoC 4 BLE, Port 6 in PSoC 4 M are the OVT pins. For PSoC 4 L Port 6 and Port 8 have
OVT pins. These are similar to regular GPIOs with the following additional features:

1. Overvoltage-tolerant - There are no ESD clamp diodes at the OVT pins. In addition, the GPIO-OVT cell has the
hardware to compare the 1/0 supply voltage (VDDIO) and the pin voltage. If the pin voltage exceeds the VDDIO
voltage, the output driver is disabled and the pin is tristated. This results in negligible current sink at the pin. Note
that the input buffer data, during overvoltage conditions at the pin, will not be valid if the external source’s
specification of VOH and VOL do not match with the trip points of the input buffer.

Provides better pull-down drive strength as compared to a regular GPIO

Serial Communication Block (SCB) - When configured as 1°C and its lines routed to OVT pins, it meets the
following I’c specifications:

a) Fast Mode Plus IOL Specification
b) Fast Mode and Fast Mode Plus Hysteresis and minimum fall time specifications
For more details on the I/O hardware, refer to the I/O System chapter of the Technical Reference Manual.

GPIO Pins in PSoC Creator

This section describes how to use PSoC Creator to configure and use GPIO pins.

Pins Component Symbols

The Pins Component is the recommended method for connecting internal PSoC resources to a physical pin. It allows
PSoC Creator to automatically place and route the signals within the PSoC device based on the chosen pin
configuration.

The standard Cypress Component Catalog contains four predefined GPIO configurations in the Ports and Pins class
of symbols: analog, digital bidirectional, digital input, and digital output. Drag one of these Components to the
schematic to add a pin to the project, as Figure 16 shows.

Figure 16. Pins Component Symbol Types in PSoC Creator
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©

2 Pins Component Customizer

Each component in PSoC Creator comes with a customizer to configure the component. Figure 17 shows the pin
component customizer, which is accessed by double-clicking on the component.

Figure 17. Pin Component Customizer
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Table 3 describes some of the parameters in the Pin customizer. For details of all the parameters, see the Pins

Component datasheet.

Table 3. Pin Component Settings

Setting

Description

General Tab -> Type

This setting configures the pin type. Possible options are:
Analog

Digital input with or without hardware (HW) connection

Digital output with or without HW connection and output enable
Bidirectional pin.

When the digital input or output is configured with no HW connection, it means, the pin state is controlled
by the CPU. Note that more than one selection can be made at once. For example, a pin can be
configured for both Analog and Digital Input at the same time.

General Tab -> Drive
Mode

This setting configures the pin with one of the eight drive modes described in the GPIO Pin Basics
section. Figure 18 lists the drive mode options in the pin customizer.

General Tab -> Initial
Drive State

The “Initial drive state” parameter sets the data register value. This value is reflected at the pin if it is
software-driven, given that the pin is set with an appropriate drive mode. If the pinis in output mode with
“HW connection” enabled and “Output enable” disabled, the “initial drive state” acts as the enable
control. Setting the initial state to 1 enables the pin, which is done as default value by PSoC Creator, as
shown in Figure 18. If the pin is configured as input, initial drive state can still be useful. For example, if
resistive pull-up is required at the input pin, then the drive mode should be configured to “Resistive pull
up” with initial state as high in order to turn on the pull up path through the resistor. Likewise, for resistive
pull down, the initial drive state should be set to low to enable the pull down path.

Input Tab ->
Threshold

CMOS and LVTTL input threshold setting is for an entire port. There are three options as Figure 19
shows. The “CMOS or LVTTL” option allows the PSoC Creator tool to select CMOS or LVTTL
depending on the threshold setting for other pins in the port.

Input Tab -> Interrupt

This setting configures the GPIO Edge Detect block described in the
GPIO Interrupt section. For more details on this setting, refer to Pins Component Interrupts.
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Figure 18. Pin Drive Mode Setting and Initial Drive State
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Figure 19. Pin Input Threshold Selection
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9.3 Pins Component Interrupts

The Interrupt parameter in the pin customizer configures the GPIO Edge Detect block described in the GPIO Interrupt
section.

Figure 20. Interrupt Configuration in PSoC Creator
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The Pins Component symbol changes when interrupts are enabled, as Figure 21 shows.

h

Figure 21. Pins Component Symbol with Interrupts Enabled
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Note that you can use only one Pin Component with each physical GPIO port if the interrupt is enabled. The reason
for this limitation is that all pin interrupts in a port are ORed together, as described in the GPIO Interrupt section.
Therefore, only one IRQ signal can be shown on the schematic per port. For example, consider two Pin Components
with interrupts enabled, as Figure 22 shows. These components cannot be mapped to pins in the same physical port.

Figure 22. Two Pins Components with Interrupts Enabled
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PSoC Creator will not allow you to assign the two components to the same port. The accepted method is to assign
multiple pins to the same component, as Figure 23 shows. This ensures that there is only one IRQ signal in the
schematic for that physical port. You can still assign each pin its own interrupt edge type. The only limitation is that
the pins must be contiguous in the same port. The interrupt source should be identified in the ISR; see the Pin
Interrupt section.

Figure 23. Multiple Pins in the Same Port with Interrupts Enabled
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The IRQ of the pin component should be connected to the Interrupt component. This routes the GPIO interrupt signal
to the interrupt controller. The interrupt component is in the Component catalog shown in Figure 24.

Figure 24. Interrupt Component in the Catalog
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B br#%g Thermal Management

The interrupt component configures the “Interrupt Source Multiplexer” to either direct connection (shown as “level” in
the Interrupt Component customizer) or the rising-edge. The GPIO interrupt architecture is described in the GPIO
Interrupt section along with the different routes available for the interrupt signal. Different routes are configured with
help of the pin component and the interrupt component customizer settings as Table 4 shows.
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Table 4. GPIO Interrupt Configurations

Schematic Interrupt setting in Interrupt Route Details
Pin Component Component
Setting
Pin 1 Risi_ng-Edge or Level Route 1 In_terrupt on edges dgpending on the
Bins Falling-Edge or Both Pin Component Setting. It uses a fixed
Edges interrupt vector depending on the
- P selected port. In this configuration GPIO
inq | _ interrupt status register should be
—==lisr_1 cleared; otherwise, interrupts are
triggered repeatedly on a single
interrupt request.
Pin 1 Rising-Edge or Rising-Edge | Route 2 Interrupt on edges depending on the
Pins Falling-Edge or Both Pin Component Setting. In this
Edges configuration GPIO interrupt should be
- e cleared; otherwise, interrupt is triggered
irq | only once. Interrupt vector is not fixed.
= isr_1
Pin 1 Risi_ng-Edge or Level Route 3 This is si_milar to Rout_e 1. H_owever,
— Falling-Edge or Both Route 3 is taken only if the interrupt
s Edges vector is forced on to a desired DSI
- |T| - vector line. See the application note
M _ AN90799 — PSoC 4 Interrupts to know
{=]isr 1 how to force the interrupt vector.
Disabled Rising-Edge Route 4 This configuration provides rising-edge
Rin_1 [i}-—+— isr_l interrupt. In this case, there is no need
to clear the interrupt.
Disabled Level Route 5 This configuration provides Level
Rin_1 [}-—+— i9f_‘ interrupt. Note that the interrupt is
triggered repeatedly as long as the pin
signal is high. In this case also, there is
no need to clear the interrupt.
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9.4 Manual Pin Assighments

You can use the Pins tab of the Design-Wide Resources (DWR) window to assign a Pins Component to a physical
pin. PSoC Creator automatically assigns pins if the user does not choose any but this may lead to a pin placement
that is more difficult to route on a PCB.

Figure 25 shows three assigned pins. The pins highlighted in gray are manually assigned and the pin highlighted in
yellow is automatically assigned. Selecting the Lock option prevents the pin from being reassigned by PSoC Creator.

PSoC Creator makes it simple to reassign pins as needed, but you should consider pin selection before the boards
are designed.

Figure 25. Pin Assignment in DWR Window
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1ED P2 [0] |2 |-
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EW sf l:.'!:l;tl.l:;.!::q:‘ £ E
(& |mmt e ==
B CYBC4245AX1-483 m [
o[ e 44-TQFP -
Enﬂzau-x Tomamar B EI
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i I
EE EERC R E
fFEFFEES
a g ;g s
Ll 1 k[ A 4
ﬁ Pins . "\ Analog @ Clocks Interrupts # System }\% Directives }\@ Flash Semrit‘,r‘ q

Note: PSoC Creator can use the unused pin switches for routing the analog signals. This is configured using the
"Unused Bonded I/O" parameter in the System tab of the .cydwr file. Refer PSoC Creator Help for more details.

9.5 PSoC Creator APIs

Cypress provides a set of API functions that you can use to control GPIOs dynamically through the firmware. The API
for the Pins Component enables access on both a Component-wide and per-pin basis. See the “API” section of the
Pins datasheet for more details.

Per-pin API functions, which are provided as part of cy boot in the cypins.h file, are documented in the “Pins”
section of the PSoC Creator System Reference Guide (Help > Documentation > System Reference). You can use
these functions to control the configuration registers for each physical pin.
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9.6 Debug Logic on GPIO Pins

The PSoC 4 serial wire debug (SWD) pins are shared on the port pins. Refer to the respective device datasheet for
more information on the debug port pins. The debug function, however, can be disabled and the pins can be used as
regular GPIOs by setting the “Debug Select” option to “GPIO” in the System tab of the DWR window as Figure 26

shows.

Figure 26. Debug

Port Disabled

*= Reset Expand I_"E| Collapse

Option

=8 Configuration

Value

- Device Configuration Mode

Compressed

- Unused Bonded IO

Allow but warn

-+ Heap Size (bytes) 0x80
- Stack Size (bytes) 0x0800
- Include CMSIS Core Peripheral Library Files
= Programming\Debugging
: Chip Protection | Cpen ~
Debug Select GPRIO -
E} Operating Conditions SWD (serial wire debug)
- VDDA (V)
- Wariable VDDA
- WDDD (V) 33
- WDDIO (V) 33

Note that disabling the debug interface does not affect the ability to program the device.

9.7  Add Multiple GPIO Pins as a Logical Port

In PSoC Creator, you can organize a group of as many as 36 pins into a logical port, which can then be referenced in
code by the port’s defined name. All the pins may be part of the same physical port, or they may form separate
physical ports. In the Pin component customizer, set the Number of Pins required in a port. The pins appear in the
list below the field as Figure 27 shows. Each pin can be configured independently. Select [All Pins] to configure

every pin in the Component with the same settings.

Figure 27. One of Four Pins Configured as a Digital Input

IyPins
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[ﬁ_\" pins] General | Input |~ Output ]
E My Pins 0 | Type Drive mode Initial drive state:
>E] MyF‘!ns_1 [T Analog [High impedance digital '] [LOW 0] ']
g :dy:ns‘i Digital input Min. supply voltage:
MyPins_ HW connection
[ Digital output
e oy
[ Bidirectional

]

7] Bdemal terminal
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I
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If the number of pins is configured to ‘4’ with three digital inputs and one digital output, the schematic symbol appears
as shown in Figure 28.
Figure 28. Pins Component in Port Configuration

MyPins
Pins
=
>
=
s =

NEngn

There is an option to display the port with bus instead of individual pin terminals. Select Display as Bus in the
Mapping tab of the pin configuration window to display the port with a bus, as Figure 29 shows. Note that all pins

must be of the same type to display a bus.
Figure 29. Display as Bus Option

? [ |

Configure 'cy_pins’

MName: MyPins

Fins /| Mapping || Clocking | Built-in

Display as bus
Selects whether to display individual terminals for each pin or a single wide teminal (bus). The bus options is only valid when
pins are homogeneous, which means that all ping in the component have the same pin type, output/input HW connections,

SI0 grouping, and they all either use or don't use the SI0 Yref.

4k

7] Cortiguous

Forces placement in adjiacent physical pins.
Partdevel APls will only be generated for this instance if it is set to be Contiguous. Per-pin APz will be globally available either

way.

Allows placement in muttiple physical ports.
MNote: Spanning is cumently configured based on the Contiguous setting. This will not be the case in the future.

o [ hw ][ s ]

[

If the Number of Pins is configured to four digital outputs, the schematic symbol appears as shown in Figure 30.

Figure 30. Four Pins Displayed with Bus

2+ [ MyPins
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The pins with the bus terminal can be forced to map to adjacent pins by enabling Contiguous in the Mapping tab as
Figure 31 shows.

Figure 31. Contiguous Pin Placement Option
Configure 'cy_pins’ M

MName: MyPFins

Pins,l; I'-'Iappingl Clocking | Built4n q b
Display as bus

Selects whether to display individual terminals for each pin or a single wide terminal (bus). The bus options iz only valid when
pins are homogeneous, which means that all pins in the component have the same pin type, output/input HW connections,
SI0 grouping, and they all either use or don't use the SI0 Yref.

Contiguous

Forces placement in adjacent physical pins.
Portdevel APls will only be generated for this instance f # is set to be Contiguous. Per-pin APls will be globally available either
Way.

Allows placement in multiple physical ports.
MNote: Spanning is cumently corfigured based on the Contiguous setting. This will not be the case in the future.

> |

b

When you select Contiguous, PSoC Creator modifies the list of available pin options to match the port's
configuration, as Figure 32 shows. When the Contiguous option is disabled, any pin can be selected. When the
Contiguous option is enabled, only adjacent pins can be selected as Figure 32 shows.

Figure 32. Pin Placement with Contiguous Disabled/Enabled

Contiguous Disabled Contiguous Enabled

Alias | Mame Port Pin | Lock Alias Mame Port Pin | Lock

MyPins[0] ||~ \Mij.ns[a.:D]\ 'v_ | |
MyPina[1] ||~ R0[3:0] )
MyFins[2] ||z BO[4:1]

MyPins[3] ||~ ig{gg}
PO[7:4]
F1[3:0]
P1[4:1]
PL[S5:2]
P1[6:3]
PL[7:4]

These features are described in more detail in the pin configuration window and the Pins Component datasheet.
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Represent Off-Chip Components

The Off-Chip Components Catalog provides a way to mix external and internal components on the same schematic,
as Figure 33 shows. This makes it possible to improve documentation and convey clearly how the internal schematic
fits in the entire design. Off-chip components serve the same function as comments in the code — they do not change
the functionality of the PSoC design but, instead, provide a clearer picture of the entire system.

Figure 33. Design with Off-Chip Components
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In the design shown in Figure 33, PWM_1 and Opamp_1 are internal blocks of the device. These blocks are connected to the
external components using pins Pin_1 throughPin_4. Green and orange wires are the internal connections (green for digital
signals and orange for analog signals); whereas, blue wires and components are external to the device. To make the
connections with the external components in the schematic, enable the “External Terminal’ parameter in the Pin component

customizer as Figure 34 shows. This brings out an additional terminal on the schematic as Figure 35 shows.

Figure 34. Enabling External Terminal
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Figure 35. Pin Component With Internal and External Terminal

External Terminal P}Q;L?‘ iy

The components, to connect to the external terminals on the schematic, are available in the Off-Chip tab in the
Components Catalog as Figure 36 shows.

Figure 36. Off-Chip Components Catalog
|Cﬂmpunent Catalog (145 compon., » 3 X

Search for... ﬂ Ll.zi @

4 [

IR Oft-Chip Component Catalog
- Active

H-e Dicdes

-4 Electro-Mechanical
-6 Passive

-~ Capaciter [v1.0]
| Crystal [v1.0]

(& Fuse [v1.0]

& Inductor [v1.0]

|| Potenticmeter [v1.0]
—|E| Resistor [v1.0]

(& Transformer [v1.0]
48 Power

-8 Sensors

%y Transistors

I_IIT|IT|ITI

The components in this catalog cover those that are most likely to be connected to the pins of a PSoC device on the
board. These components consist of resistors, capacitors, transistors, inductors, switches, and others. Drag the
component and place it on the schematic as it is done in the case of internal components.
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10 GPIO Tips and Tricks

This section provides practical examples of how to use GPIO pins. All these examples are included in the PSoC
Creator project provided with this application note.

Table 5. PSoC Creator Projects

# Section Project PSoC | PSoC | PSoC | PSoC PSoC PSoC PSoC PSoC
4000 4100 4200 41x7_BLE | 42x7-BLE | 4100M | 4200M | 4200L

1 Toggle an LED Project01_ToggleLED v v v v v v v v

2 Read an Input and Project02_ReadingPin v v v v v v v v
Write to an Output

3 Drive an Output Project03_HWDrive
from a Digital Logic v v v v
Gate

4 Using a Project04_BidirectionalPi v v v v v v v v
Bidirectional Pin n

5 Set the GPIO Project05_GPIOSynchron
Input/Output ization v v v v v v v
Synchronization

6 Toggle GPIOs Project06_FastGPIOUpd
Faster with Data ate v v v v v v v v
Registers

7 Configure GPIO Project07_OutputEnable
Output Enable v v v v
Logic

8 Pin Interrupt Project08_PinInterrupt v v v v v v v v

9 Configure GPIO Project09_GPIOIntConfig
Interrupt Settings v v v v v v v v
with Firmware

10 | Using Both Analog Project10_GPIOAnalogDi
and Digital on a gital v v v v v v v v
GPIO

11 | Gang Pins for More | Projectll_GangingPins v v v v
Drive/Sink Current

12 | Control Register Project12_ControlRegInD
Handling in Deep- eepSleep v v v v
Sleep

The Cypress development kits, listed in Appendix B: PSoC 4 Development Boards, can be used for testing these

projects.
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10.1 Toggle an LED
The simplest use of a GPIO is to set the output of a pin HIGH or LOW in the firmware. This example demonstrates
how to set the output to toggle an LED using the Pins Component API.

1. Place a Digital Output Pin Component in the project schematic.
2. Name the Component “Pin_LED” and disable the hardware connection as Figure 37 shows.

Figure 37. Pin_LED Configuration

-

Configure 'cy_pins

[IER==)

Name: Pin_LED)

A Pins [ Mapping

Clocking | Builtdn

q b

Mumber of pins: 1

X R+ +|8 3

General ] Input |* Output

Initial drive state:

)

[Low ) -

Digital output
7] HW connection i
[ Output enable

[ Bidirectional
| BExtemal terminal

Type Drive mode
[C] Analog Strong drive
[ Digital input i

Min. supply voltage:

S

3. Enable the external terminal to connect to the external components on the schematic
Assign it to a physical pin (this example uses P1[6]) in the Pins tab of the DWR window).

5. Connect the physical pin to an LED. Note that the LED and resistor R are off-chip components. The Top Design

schematic is shown in Figure 38.
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Figure 38. Toggle an LED Example Schematic
Vdd
o
*u
I
%E o
- I
— Pin_LED .
£— 18] ——————————— - '
In main.c, use the Component API to set the output as follows:
for(; ;)

{
/* Set LED output to logic HIGH */

Pin LED Write(lu);

/* Delay of 500 ms */
CyDelay (500u) ;

/* Set LED output state to logic LOW */
Pin LED Write (Ou);

/* Delay of 500 ms */
CyDelay (500u) ;

6. Build the project and program the PSoC 4 device.
The result is an LED blinking at a frequency of 1 Hz.

10.2 Read an Input and Write to an Output
This example demonstrates how to read from and write to a GPIO pin with the Component APIs. The output pin

drives the inverse of the input pin state.
Place two pins in the project schematic—one Digital Input Pin and one Digital Output Pin with hardware
connection disabled—as Figure 39 shows.

Figure 39. Input and Output Example Schematic

1.

Pin_Input [« = =m| Pin_Qutput

2. Assign the pins for Pin_Input and Pin_Output in .cydwr
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3. Use the Component APIs to set the state of Pin_Output based on Pin_Input as follows:

for (;;)

{
/* Set the output pin with an inverted value of input pin */
Pin Output Write (~Pin_ Input Read());

}

4. Build the project and program the PSoC 4 device.

You can test this project by feeding a square wave from a signal generator to the Pin_Input. The signal at Pin_Output
will be an inverted form of Pin_Input signal.

10.3 Drive an Output from a Digital Logic Gate

The previous example showed the use of the processor core to read a pin and set another pin with an opposite of the
read value. This example demonstrates the same task but with the use of configurable digital resources known as
Universal Digital Blocks (UDBSs). In this example, an input pin signal is routed to the NOT gate and the output of the
NOT gate is routed to another pin. Follow these steps to create the project:

1. Place two pins in the project schematic—one Digital Input Pin and one Digital Output Pin with hardware
connection enabled—as Figure 40 shows.

Figure 40. Input and Output Pins with HW Connection Enabled
Pin_Input [+] - ‘= o] Pin_Output

2. Place a NOT gate and connect to the pins as Figure 41 shows.

Figure 41. NOT Gate Connection
- Cypress [ Off-Chip 4 b

ﬂ Cypress Compenent Catalog
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--Qg Communications

EHgg Digital
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Pin_Input [+ = — ~Do— — = [x] Pin_Output 18T And 11.0]

-[¢] Bufoe [v1.10]

-2} D Flip Flop [v1.30]

-[¢| DFlip Flop w/ Enable [v1.0]

%] De-Multiplexer [v1.10]

--¢| Digital Constant [v1.0]

lﬂ} Logic High '1' [v1.0]
.ﬂ Logic Low '0' [v1.0]

~#| Lockup Table [v1.50]

~#| Multiplexer [v1.10]

~[#] Mand [v1.0]

%] Or[v1.0]

- -[8] SR Flip Flop [v1.0]

3. Assign the pins for Pin_Input and Pin_Output in .cydwr
4. This project does not require any code. Build the project and program the PSoC 4 device.

Similar to the previous project, you can test this project by feeding a square wave from a signal generator to the
Pin_Input. The signal at Pin_Output will be an inverted form of Pin_Input signal.
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0.4 Using a Bidirectional Pin
This example demonstrates the use of a pin in the bidirectional mode, that is, with both digital input and digital output
active. PSoC Creator provides a Pin Component in bidirectional configuration - “Digital Bidirectional Pin”.

o] Pin_Bidirectional

This pin component, however, shows a single terminal for both input and output. Its use is limited to the I°C SDA and
SCL lines. In many applications, it is useful to have two terminals — one for input and one for output. This can be done
by enabling both the Digital Input and Digital Output options in the Pin Component customizer. An example is shown
for configuring such a pin, where a switch is connected at the input side to pull the pin to logic LOW. This pin is
configured to resistive pull up with logic 1 driven continuously. To check the bidirectional pin status, the pin signal is
routed to another pin. Follow the steps below to create the project:

1. Place a Digital Input Pin on the schematic.
2. Enable Digital Output also with resistive pull up drive mode as shown in Figure 42.

Figure 42. Pin_Bidirectional Configuration

Configure 'cy_pins I. T

MName: Pir_Bidirectional
~ Pins [© Mapping | Clocking [ Builtdn 4r
Number of pins: 1 | A+ | B = |
[ﬁl\II pins] " General |" Input © Output
=[] Bin_1_0 Type Drive mode Initial drive state:
1 s ion
Digital input ia Min. supply voltage:

HW connection
Digital output

HW connection bR

[T Output enable
1 [ Bidirectional

__'_ | S | _'—_ D Extemal terminal

% ) [ o

Ensure that the component look like Figure 43 on the schematic.
Figure 43. Pin_Bidirectional on the Schematic

Pin_Bidirectional
Pins

e
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3. Connect alogic HIGH to drive the pin with resistive pull up continuously as shown in Figure 44.
Figure 44. Logic HIGH to Pin_Bidirectional
Pin_Bidirectional
Pins

SR

Now, the pin status is seen using another pin (Pin_Status) connected at the input side. Place a digital output pin
and connect at the input buffer side of the Pin_Bidirectional as shown in Figure 45.

4,

Figure 45. Pin_Status Connection to Pin_Bidirectional
Pin_Bidirectional
Pins

~ o [] «} — =[] Pin_Status

With the external connections enabled, schematic looks like Figure 46
Figure 46. Complete Schematic

Vdd
b
o
Pin_Bidirectional
Pins ?:
: . Pin_Status | -
I - o
SW_1
== —//-—_ I
\/ss

5. Assign the pins in .cydwr.

6. The project doesn’t require any user code. Build the project and program the PSoC 4 device.

The LED connected to the Pin_Status shows the input buffer state of Pin_Bidirectional. When the switch is not
pressed, logic 1 drives Pin_Bidirectional with a resistive pull up. This turns OFF the LED (as the LED is connected in
active LOW mode). When the switch is pressed, strong logic O appears at Pin_Bidirectional. This turns ON the LED.
Thus, this project demonstrates two drivers on the same pin (Pin_Bidirectional) — one from internal (logic 1) and other

from external (switch) with an input.
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10.5 Set the GPIO Input/Output Synchronization

For digital input and output signals, the GPIO provides synchronization with an internal clock, HFCLK, or a digital
signal as a clock in the PSoC 4 parts (except PSoC 4000). In addition, it provides the configuration for clock enable
and synchronization logic reset. Port adapter logic is used for input and output synchronization, as Figure 47 and
Figure 48 show.

Figure 47. Input Synchronization in PSoC 4

Selected
Reset
—» To DSI
From
Input Pin
2
PACFGx
IN SYNC[1:0]
00: Transparent
Selected I
Sync Clock 01: Single Sync

10: Double Sync
11: Reserved

As Figure 47 shows, the input synchronization circuit provides the options of transparent, single sync, and double
sync.

Figure 48. Output Synchronization in PSoC 4

Selected

Reset

From i

DSl —» To Pin
o—(
2
Selected
Sync Clock PACFGx

OUT SYNCJ1:0]

00: Transparent
01: Single Sync
10: Clock

11: Clock Inverted

The output synchronization circuit provides the options of transparent, single sync, clock, and clock inverted, as
shown in Figure 48. Clock and clock inverted route the sync clock to the output pin. These are set in the Pins
Component customizer, as Figure 49 shows.
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The synchronizer clock can be configured as HFCLK, an external signal (from DSI), or one of the pin signals. The
synchronizer block reset signal can be an external signal (from DSI) or one of the pin signals. These are configured in
the Pins Component customizer from the Clocks tab, as Figure 50 shows.

For more information on the parameters in the Clocking tab of the Pins Component customizer, refer to the Pins
Component datasheet.

Figure 49. Sync Mode Setting

s — S
Configure ‘cy_pins 2
onfigure ‘cy._pins . - uﬂ
Name: Pin_Bidirectional
Pins || Mapping | Clocking  Builtin 4 b
Mumber of pins: 1 | XK+ 3+ | B I |
[J'-f-"PiﬂS] General / Input | Output I |
i-[4] |Pin_Bidiractional 0 .
== [CMOS hd General [ Input.”” Output ]
I Slew rate: [Fast ‘]
Intemupt: [None—'] Drive level: [Vddin ‘]
I Symemede: | Double-syne M Curment: [41111\ source, 8mA sink v]
I Single-sync utput mode: | Transparent -
Transparent ET—
. ) Single-Sync
__'_ T ™ Clock
o Clock-Inverted
k.
Figure 50. Clock Setting
F B
Configure 'cy_pins’ - M
MName: Pin_Bidirectional
Pins |* Mapping i Clocking [ Built-in 4k
Input clocking
|| ook |HFCLK -
I In clk en: [N‘,ne .] Rising edge Input Synchronization
In reset: ’None ']

I QOutput clocking
Outclock:  |HFCLK -

Out clk en: [None v] Rising Edge Output Synchronization i
[7] Output reset  [] OF reset

Feset signal: ’None ']

Pin signals are synchronized using a combination of the UDB port adapter and GPIO blocks. Also, the clock is shared
for all the pins of a port for internal clock synchronization. For more information, refer to the PSoC 4 Architecture TRM.

Note: The signals at port 4 and higher port pins cannot be synchronized because these ports do not have a UDB port
adapter. Therefore, these port pins should always be used in the Transparent mode to avoid an error during build.

The next two examples demonstrate how to set the input/output synchronization.
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10.5.1 GPIO Input Synchronization
1. Place one Digital Input Pin, two Digital Output Pins, and one Clock Component in the project schematic.

Configure them as Table 6 shows.

Table 6. Components Configuration

Component

Name

Configuration

Digital Input Pin

Pin_Input_DoubleSync Drive Mode: Resistive Pull-Up

Sync Mode: Double-Sync
In Clock (for input sync): External

Digital Output Pin

Pin_Output_LFCLK

1 Output Mode: Transparent

Digital Output Pin

Pin_Output_Transparent_1 Output Mode: Transparent

Clock

LFCLK

Clock Type: Existing
Source: LFCLK

2. Connect the pins and add the Off-Chip Components, as Figure 51 shows.

Figure 51. GPIO Input Synchronization Example Schematic

GPIO Input Synchronization

LFCLK

32 kHz

Vss

— + | Pin_Output_LFCLK_1

— ] Pin_Output_Transparent_1

Note: Clocks in PSoC 4 cannot be directly connected to a pin terminal, except for SYSCLK and LFCLK. See the
"Clocking System" section of the PSoC 4 Architecture TRM for more information.

3. Assign the pins, and connect the Pin_Input_DoubleSync pin to a switch connected to GND.

4. Build the project and program the PSoC 4 device.

When the button connected to Pin_Input_DoubleSync is pressed, the signal waveforms occur as Figure 52 shows.
The Pin_Output_Transparent_1 pin becomes LOW at the second rising edge of LFCLK because the input is double-

synchronized with LFCLK.
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Figure 52. Input/Output Signal Waveforms
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10.5.2 GPIO Output Synchronization

1. Place one digital input pin, three digital output pins, and one Clock Component in the project schematic, as
Figure 53 shows, and configure them as described in Table 7.

Figure 53. GPIO Output Synchronization Example Schematic

GPIO Output Synchronization

-~ — o] Pin_Output_LFCLK_2

Pin_Output_SingleSync

Pins
LFCLKR 1 out_clk
32 kHz
SW_1 . el
: ~ Pin_Input_Transparent ] |
J7 -~ — = {o| Pin_Output_Transparent_2

Vss
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Table 7. Pins Configuration

Component Name Configuration
Digital Input Pin Pin_Input_Transparent Drive Mode: Resistive Pull-Up
Sync Mode: Transparent
Digital Output Pin Pin_Output_LFCLK_2 Output Mode: Transparent
Digital Output Pin Pin_Output_SingleSync Output Mode: Single-Sync
Out Clock (for output sync): External
Digital Output Pin Pin_Output_Transparent_2 Output Mode: Transparent
Clock LFCLK Clock Type: Existing

Source: LFCLK

Connect the pins as Figure 53 shows.

w N

Assign the pins, and connect the Pin_Input_Transparent to a switch connected to GND. Note that you cannot
select Port 4 and higher port pins for Pin_Output_SingleSync as they don’t support synchronization.

4. Build the project and program the PSoC 4 device.
Figure 54 shows the waveforms corresponding to a button press.

The Pin_Output_SingleSync pin becomes LOW at the next rising-edge of LFCLK because the output is synchronized
with LFCLK. The Pin_Output_Transparent_2 pin becomes LOW at the same time as the Input_Transparent pin
because there is no synchronization.

Figure 54. Input/Output Signal Waveform
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10.6 Toggle GPIOs Faster with Data Registers
The Component APl is the easiest way to control GPIO pins; however, it is not the fastest way.

Take an example of writing logic 1 to Pin_1 mapped to pin P5[2]. Here is the API function call:

Pin 1 Write(1l);

The equivalent assembly code can be seen in the listing file (main.Ist) in the results tab of the project workspace.

mov r0, #1 ;load the value in r0

bl Pin 1 Write ;call Pin 1 Write

The assembly code of component API Pin_1_Write function can also be seen in the listing file-

ldr r3, .L2 ;load the address of Pin 1 DR into r3
ldr rl, [r3] ;load the value of Pin 1 DR into rl
mov r2, #251 ;load 251 into r2 (value depends on location of pin

;in 8 bit wide port, in this case, Pin 1 is on port P5[2])

and r2, rl ;AND the values of r2 and rl and load result back in r2

1sl r0, r0, #2 ;left shift r0 by two bits and load the result back in
;r0(this instruction is not present for the pin on LSB)

mov rl, #4 ;load value of 4 into rl (depends on the location of
;pin in 8 bit wide port)

and r0, rl ;and the value of r0(contains "value")and rl and load
;the result in rO

orr r0, r2 ;or the value of r0O with r2 and load the result back in
;r0

str r0, [r3] ;store the result back in Pin 1 DR

bx 1r ;return to calling function

This code takes 20 CPU cycles to write logic 1 to Pin_1.

Alternatively, you can use the register definitions and masks in the <pin_name>.h file that is created for each Pins
Component to update the pins quickly.

The following statement sets logic 1 at Pin_1 mapped to P5[2]. Pin_1_DR is the data register of Pin_1.

| Pin 1 DR |= Pin 1 MASK

In the listing file (main.Ist),, the above instruction translates into an assembly code as follows:
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ldr r3, .L3 ;load the address of Pin 1 DR into r3

1ldr rl, [r3] ;load value of Pin 1 DR into rl
mov r2, #4 ;move value of 4 (Pin 1 MASK) into r2
orr r2, rl ;Set the bit in Pin 1 DR

strb r2, [r3] ;Store it back into Pin 1 DR

This code takes eight cycles as against 20 cycles used by the component API.

The component API had firmware overhead for the following actions, which are not required in direct register writes:

®  Function call
m  Checking the function argument to set the pin to logic 1 or logic 0
= Return from the function

To set, reset, and read the pin using direct register writes, the following macros are provided in PSoC Creator:

Macro Description

CY SYS PINS SET PIN(portDR, pin) Sets the output value for the pin to logic high
portDR isthe address of the port data register

pin isthe pin number (0 to 7)

CY SYS PINS CLEAR PIN(portDR, pin) | clears the output value for the pin to logic low

portDR isthe address of the port data register
pin isthe pin number (O to 7)

CYﬁSYSip T\TsiREADip IN (portPS, pln) Reads the pinvalue

portPS isthe address of the port status register

pin isthe pin number (O to 7)

Refer to the System Reference Guide (available from the PSoC Creator Help Menu) for more details on these

macros.

Follow these instructions to create a PSoC Creator project that can be used to compare the performance of the API

function call and direct register write:

1. Place two digital output pins, with hardware connection disabled, in the project schematic and name them

“Pin_Test” and “Pin_Index,” as Figure 55 shows.

Figure 55. Toggle GPIOs with Data Registers Example Schematic

—{ao| Pin_Test

-2[2I| Pln_lr'ldE}X

2. Assign the pins in .cydwr.

WWW.Cypress.com Document No. 001-86439 Rev.*C

44



http://www.cypress.com/

PSoC® 4 — Using GPIO Pins

3. Add the following code to the main.c file. The code sets the Pin_Index HIGH and toggles Pin_Test using the
Component API. It then sets the Pin_Index LOW and toggles Pin_Test using the data register (DR).
for(;;)
{

/* Set IndexPin */
Pin Index Write(1l);

/********************* API Call ********************/

/* Set TestPin */

Pin Test Write(lu);

/* Clear TestPin */
Pin Test Write (Ou);

/* do it again */
Pin Test Write(lu);
Pin Test Write (Ou);

/***************************************************/

/* Clear IndexPin */
Pin Index Write(0);

/************* Direct Register Writes **************/

/* Set TestPin */
CY SYS PINS SET PIN(Pin Test DR, Pin Test SHIFT);

/* Clear TestPin */
CY SYS PINS CLEAR PIN(Pin Test DR, Pin Test SHIFT);

/* do it again */
CY SYS PINS SET PIN(Pin Test DR, Pin Test SHIFT);
CY SYS PINS CLEAR PIN(Pin Test DR, Pin Test SHIFT);

/***************************************************/

Note Pin Test DR is the address of the data register; whereas, Pin Test DR is the value of the data
register. See the pin component .h file in the Source Files of the project workspace (in this case Pin Test.h) to
know the macro for the data register address.

The code that writes to the data register is also portable similar to the API call, so that if the pin assignment changes
during development, you do not have to change the code.
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10.7

4. Observe the waveform of the two pins using an oscilloscope, as shown in Figure 56.

Figure 56. Output Signals Waveform

Pin_Index

It e st b S g By e A oA B i A T i e TP R ]

Pin_Test

A. Pin_Test_Write(1u)
B. Pin_Test_Write(Ou)
C.CY_SYS_PINS_SET_PIN(Pin_Test_ DR, Pin_Test_SHIFT)

D. CY_SYS_PINS_CLEAR_PIN(Pin_Test_ DR, Pin_Test_SHIFT)

Figure 56 shows that a pin can toggle faster by directly writing to the data register, as opposed to calling the API
functions.

To know about coding techniques to achieve time efficiency, refer to the application note, AN89610 — PSoC 4 and
PSoC 5LP ARM Cortex Code Optimization.

Configure GPIO Output Enable Logic

This example demonstrates how to configure and use the output enable logic of a GPIO pin. This project is applicable
only for PSoC 4200, PSoC 42xx_BL, PSoC 4200M and PSoC 4200L parts.

1. Place two Digital Output Pins in the project schematic.
2. Open the configuration dialog for each pin and select the Output Enable option, as Figure 57 shows.

Figure 57. Output Enable Selection

Configure ‘cy_pins' 9
Name: Pin_Output 1
Pins | Mapping |' Cocking ' Buit-in 4 b
[Al pins] " General | Inout | Output | 3
Pn_Outout1_0 Type Drive mode Intial drive state
Analog | Strong drive v Hgh (1 '
|| Digtal input = Mn. supply voltage
v Digtal output Hot swap A
¥ HW connection 1
= V| Output enable
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= g Extemal terminal
(. Dttt Lo J[ ww [ coes
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3. Place a Control Register in the schematic.
4. Configure the Control Register for two outputs, as Figure 58 shows.

Figure 58. Control Register Configured With Two Outputs

Configure 'CyControlReg’ I. 2 &J
Name: Control_Reg

" Configure |~ Builtin 4 I
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0 | Direct =0 -

[ Display as bus
1 Direct - |0 -
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5. Add one Logic Low ‘0’ Component.
6. Connect the Logic Low to the pins and add the Off-Chip Components for the LEDs, as Figure 59 shows

Figure 59. Control Register Driving Pins' Output Enable

B
DI KK e
D2 XX

(0] ‘ w1l Pin_Output1 AAA
2.2K
Control_Reg
Control Reg R2
om0 ‘ . Pin_Output2 AAA
control_1 2.2K

7. Assign the pins and connect the pins to LEDs.
8. Add the following code to the main.c file.

uint8 count;

for(;;)
{

for (count = 0Ou; count < 4u; count++)

{
/* Set Control Reg Value */

Control Reg Write (count);

/* Delay for 500ms */
CyDelay (500u) ;
}

}
9. Build the project and program the PSoC 4 device.
The result is the output of the two pins gated by the state of Control_Reg, which causes the LEDs to “count” to 3
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Pin Interrupt
This example demonstrates how to use an interrupt generated from two pins in the same port, using the Component
APIs. These two pins can use only one IRQ terminal. Thus, the interrupt source must be identified in the ISR.

Place two pins in the project schematic: one Digital Input Pin hamed Pin_Button and one Digital Output Pin

1.
named Pin_LED.
2. Set Pin_Button’s number of pins to 2, Drive mode as Resistive Pull Up, and Interrupt as Falling-Edge. This
exposes the IRQ terminal.
3. Connect the interrupt component to the irq terminal as shown in Figure 60.
Figure 60. Pin Interrupt Example Schematic
Pin_Button
SW_1 Pins
'_:-"ff_ _____ _..qm s
, SW 2 |
- r- -
. irg |
47 —{=]isr_Button
Vss
Widd
R1 D1 EF, —|_
Pin LED |
=T — M- ——---
22K
4. Assign the pins in .cywdr
5. Use the Component APIs to set the state of the LED Pin based on Pin_Button. Copy the following main.c code:
#define LED ON (Ou)
#define LED OFF (1lu)

/* The flag to enter ISR Button */
uint8 isrFlag = 0Ou;

/* The LED state */
uint8 ledState = LED OFF;

/* ISR for ISR Button */
CY TSR(INT ISR Button)

{
/* Set the flag */

isrFlag = 1lu;

/* Check which pin caused interrupt by reading interrupt status register */
if (Pin Button INTSTAT & (0xOlu << Pin Button SHIFT))
{
/* Triggered by Pin Button 0 */
ledState = LED OFF;
}

else
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/* Triggered by Pin Button 1 */
ledState = LED ON;
}

/* Clear interrupt */
Pin Button ClearInterrupt();

}

int main ()

{
/* Start Pin ISR */

isr Button StartEx (INT ISR Button);

/* Enable global interrupt */
CyGlobalIntEnable;

for(;;)

{
/* Check the flag */
if(0u != isrFlag)

{
/* Clear the flag */

isrFlag = Qu;

Pin LED Write (ledState);
}

/* Delay lms */
CyDelay (1lu);

/* Drive the LED with ledState.

Led State is updated in ISR */

In the main.c code, CY ISR(INT ISR Button) is the interrupt service routine for the pin interrupt.

6. Build the project and program the PSoC 4 device.

The result is that the LED turns OFF when you press the button connected to Pin_Button_0 and turns ON when you
press the button connected to Pin_Button_1, but not when you release the buttons. (Note that the switch bounce in
the buttons may cause several interrupts on a single button press; see AN60024 — Switch Debouncer and Glitch

Filter with PSoC 3, PSoC 4, and PSoC 5LP for details).

In the main.c code, Pin_Button_INTSTAT and Pin_Button_SHIFT are the functions and constant macros provided by

the Pins Component. These are used to check which pin caused an interrupt.

The function Pin_Button_ClearInterrupt() clears the interrupt status register.
For more information on interrupts and writing interrupt handlers, refer to AN90799 — PSoC 4 Interrupts.
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10.9 Configure GPIO Interrupt Settings with Firmware

The GPIO interrupt is configured dynamically by writing to the two bits of the Interrupt Configuration register.

m For PSoC 4000: GPIO_PRTx_INTR_CFG[2y+1:2y]
m  For other PSoC 4 parts: PRTX_INTCFG[2y+1:2y]

where “X’ corresponds to the port number and “y” corresponds to the pin number (see Table 8). You can change the

configuration at any time to enable or disable pin interrupts.

Table 8. GPIO Interrupt Types and Bit Settings

PRTX_INTCFG [2y+1:2y] Edge Type Description
0 Disable Interrupts disabled
1 Rising-Edge Trigger on rising edge
2 Falling-Edge Trigger on falling edge
3 Both Edges Trigger on either edge

In this example, Pin_Button is configured with a rising-edge interrupt. Once the interrupt occurs, it is configured as a
falling-edge interrupt. An LED is toggled whenever the interrupt is triggered.

1. Place a Digital Input Pin and a Digital Output Pin in the project schematic. Add the Off-Chip Components for the
LED and button, as Figure 61 shows.

Figure 61. Example Schematic

SW_1 - Vdd
ST PinButon,
Pin LED R d
i |
| L - YV S— -

Vss

Assign the pins to Pin_Button and Pin_LED in cydwr.
Configure Pin_Button as a resistive pull-up pin and connect it to a button.
Configure Pin_LED as a strong drive pin and connect it to an external LED.

Add the following code to the main.c file. Note that instead of using the device register name, this project uses
Pin_Button__INTCFG, provided by PSoC Creator (in the cyfitter.h file) for the interrupt configuration. You do not
need to worry about the exact register name in the selected device. This helps to port the project to a different
PSoC 4 device without changing anything in the code.

a b~ wDN

#define INTERRUPT MASK 0x03
#define RISING EDGE 0x01
#define FALLING EDGE 0x02

int main ()

{
/* Variable to save temporary data */
uint32 regvVal = 0x00u;

/* Flag to switch interrupt type */
uint8 edgeFlag = 0x00u;
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for (;;)

/* Get value of port interrupt configuration register */
regVal = CY GET REG32 (Pin Button INTCFG);

/* Clear the configuration bits for the Pin Button.

Pin Button SHIFT is multiplied by 2 as two bits of the interrupt
configuration register sets the configuration for one pin */
regVal &= ~(INTERRUPT MASK << (Pin Button SHIFT * 2));

if (edgeFlag)
{
/* Set PO[7] to GPIO interrupt rising-edge trigger.
Pin Button SHIFT is multiplied by 2 as two bits of the
interrupt configuration register sets the configuration for
one pin */
CY SET REG32 (Pin Button INTCFG, regVal | (RISING EDGE <<
(Pin Button SHIFT * 2)));
}
else
{
/* Set PO[7] to GPIO interrupt falling-edge trigger.
Pin Button SHIFT is multiplied by 2 as two bits of the
interrupt configuration register sets the configuration for
one pin */
CYisETiREG32(Pin_Button__INTCFG, regVal | (FALLING EDGE <<
(Pin Button SHIFT * 2)));
}

/* Toggle edgeFlag */
edgeFlag "= 0x01lu;

/* Wait for Interrupt */
while (! (CY GET REG32(Pin Button INTSTAT) & (0x0lu <<
Pin Button SHIFT))) {;}

/* Clear interrupt */
CY SET REG32(Pin Button INTSTAT, (0x0lu << Pin Button SHIFT));

/* Toggle LED */
Pin LED Write(~Pin LED Read());

6. Build the project and program the PSoC 4 device.
The LED toggles whenever the button is pressed or released. When the button is pressed, the falling-edge triggers
the interrupt, and when it is released, the rising-edge triggers the interrupt.

The PSoC 4 Architecture TRM contains more information about the GPIO interrupt, including block diagrams and
functional descriptions. Another good resource is the application note AN90799 — PSoC 4 Interrupts.
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10.10 Using Both Analog and Digital on a GPIO

This example demonstrates how to configure and use a pin for analog and digital functions. In this example, an
output pin is controlled alternately by an IDAC and the firmware. When controlled by the firmware, the LED blinks.
When controlled by the IDAC, the LED gradually brightens.

This type of multiplexing is useful when you need analog and digital functionality from a single pin. It can also reduce
the number of GPIOs used in a design.

You can use a hardware connection instead of firmware to control the digital output. See the description at the end of
this section for the required modifications to the project.

To configure the pin signal source, the HSIOM_PORT_SELX register is updated. Like the previous example, this
project uses the register name as defined in the Pins Component for easy portability across the PSoC 4 device family.

Follow these steps to create the schematic and firmware:

1. Place an Analog Pin and a Current DAC in the schematic.
Assign the Pins Component to a physical pin (this example uses P0[2]).
Configure the pin with both Analog and Digital Output settings, as Figure 62 shows.

Set the IDAC’s Polarity as Negative (Sink), as Figure 63 shows. Connect the IDAC to the analog terminal, as
Figure 64 shows.

5. Build the project to create the necessary APIs.
Figure 62. LED Pin Configured as both Analog and Digital
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Figure 63. IDAC Setting
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Figure 64. PSoC Creator Schematic of Analog and Digital Switching Scheme
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6. Add the following code to the main.c file and build the project again. Program the device with the hex file
generated. Note that in this code, the macros defined in the Pins Component and Cyfitter.h are used.

#define HSIOM SW GPIO 0x00
#define HSIOM AMUX BUS A 0x06

int main ()
{
uint32 i = Ou;
uint32 regvVal = 0x00u;

/* Disable Input Buffer */
Pin LED INP DIS |= (0x0lu << Pin LED SHIFT);

/* Start IDAC */
IDAC Start();

for(;;)
{
/* Get the current value of HSIOM PORT SELO register */
regvVal = CY_GET_REG32(Pin_LED_O_HSIOM);
regvVal &= ~Pin LED 0 HSIOM MASK;
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/* Set LED Pin as GPIO controlled by firmware */
regval = CY SET REG32(Pin LED 0 HSIOM, regVal | (HSIOM SW GPIO <<

Pin LED 0 HSIOM SHIFT));

/* Set LED Pin to Strong Drive Mode */
Pin LED SetDriveMode (Pin LED DM STRONG) ;

for(i= Ou; 1 < 5u; i++)
{
/* Toggle LED with 100-ms delay */
Pin LED Write (Ou);
CyDelay (100u) ;
Pin LED Write (lu);
CyDelay (100u) ;
}

/* Get the current value of HSIOM PORT SELO register */
regVal = CY_GET_REG32(Pin_LED__ 0__ HSIOM);
regVal &= ~Pin LED 0 HSIOM MASK;

/* Connect LED Pin to AMUXBUS-A */
CY SET REG32(Pin LED 0 HSIOM, regval | (HSIOM AMUX BUS A <<

Pin LED 0 HSIOM SHIFT));

/* Set LED Pin to High Impedance-Analog Drive Mode */
Pin LED SetDriveMode (Pin LED DM ALG HIZ);

for(i = Ou; 1 < 0x7fu; 1i++)

{
/* Adjust LED brightness */
IDAC_SetValue (i) ;

/* Delay 20 ms */
CyDelay (20u) ;

The result is an output that alternates control by the firmware and IDAC.

You can easily modify this project to use a hardware connection for the digital output instead of the firmware control.
To do so, in step 3, enable the HW connection in the pin configuration window. You can then wire a digital resource
to the pin. To select this digital resource as the pin output, set the pin as a DSI-controlled GPIO or a pin-specific
digital resource connection, using the HSIOM_PORT_SEL register. See the PSoC 4 Architecture TRM for more

details.
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10.11 Gang Pins for More Drive/Sink Current

To increase the total source or sink capabilities of the circuit, GPIO pins can be ganged (shorted together). This
example demonstrates driving a PWM signal with four GPIO pins. Note that the project is applicable only for
PSoC 4200, PSoC 42xx_BL, PSoC 4200M and PSoC 4200L parts.

1. Place and configure a PWM (TCPWM mode) and a Clock Component in the schematic.
2. Place a single Digital Output Pins Component.
3. Connect the Components as Figure 65 shows.

Figure 65. PWM Driven to Single Pin
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line
line_n (=

Clock[ |- —[clock

128 kHz interrupt |-

4. Open the pins configuration dialog and set the number of pins accordingly, as Figure 66 shows. This example
uses four GPIO pins. Set the Output Mode to Single-Sync and Out Clock to External, as Figure 67 and Figure

68 show.
Note: Synchronize the output to avoid different output signal delays for the different pins.

Figure 66. Configure Multiple Pins in the Component
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Configure 'cy_pins’
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-~ Pin_Gang_2 [ Digital input i Min. supply voltage:

----- E Pin_Gang_3

Digital output
HW connection R
[ Output enable

[ Bidirectional

[ Bdemal terminal
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Figure 67. Output Mode Setting
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Figure 68. Out Clock Setting
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5. (Optional) Set the pin mapping to Contiguous for easier PCB routing, as Figure 69 shows.
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Figure 69. Enable Contiguous Mapping
Configure 'cy_pins’ ——— . - |. 2 &r

MName: Fin_Gang

" Pins. " Mapping | Clocking | Builtsn 4b
[ Display as bus
Selects whether to display individual terminals for each pin or a single wide terminal (bus). The bus options is only valid when
pins are homogeneous, which means that all pins in the component have the same pin type, output/input HW connections,
51O grouping, and they all either use or don't use the SI0 Vref.

Contiguous

Forces placement in adjacent physical pins.
Portdevel APls will only be generated for this instance if i is set to be Contiguous. Per-pin APls will be globally available either

way.

Allows placement in multiple physical ports.
Mote: Spanning is cumently configured based on the Contiguous setting. This will not be the case in the future.

6. Assign the Pins Component to physical pins.

Place a Sync Component and connect the signal source (PWM, in this example) to each of the pin terminals via
the Sync Component. Place another Clock Component and set its source to High Frequency Clock (HFCLK).
Connect the out_clk terminal of the Pin Component and the Clock terminal of the Sync Component to the HFCLK.

It is important to select a high-frequency synchronization clock to reduce the difference in pin signal delays. The Sync
Component is required to synchronize the signal crossing from one clock domain to another. In this case, the PWM
output is going to cross from Clock (1 kHz) domain to HFCLK.

Figure 70. PWM Driving Four Pins

PWM
PWM
ov|=]
unf
celo Sync
Sync
line |- —{s_in s_out |- &= Hﬁf”w:
line_n =) o fm oo TO LOAD
Clock[_}- —[>clock T
1 kHz i IS et ____
interrupt |- Nelock ol
—{out_clk
Pins
HFCLKD F’ln_Gang
24 MHz

8. Build the project and program the PSoC 4 device.

The output of the PWM is driven on all four GPIOs. The pins can be shorted externally on the PCB and connected to
the external circuit as needed.
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10.12 Control Register Handling in Deep-Sleep
This example demonstrates freezing of GPIO pins to avoid glitches at the output while using the low-power modes.
As an example, consider a Control Register driving a pin. When the device enters the Deep-Sleep mode, all I/Os are
frozen without any user intervention. When the device wakes up, all the 1/0Os are automatically restored to their
original configuration. However, the Control Register loses its data in the Deep-Sleep mode. It needs to be restored
before the 1/Os are unfrozen. Otherwise, there is a glitch at the output. PSoC 4 provides alternate control for the user
to freeze and unfreeze the GPIOs in the form of CySysPmFreezeIo () and CySysPmUnfreezelIo () APIs. Follow
these steps to create the PSoC Creator project. Note that this project is applicable only for PSoC 4200,
PSoC 42xx_BL, PSoC 4200M and PSoC 4200L.

1. Place one Digital Input Pin, two Digital Output Pins, a Clock, a Control Register, and an Interrupt Component in

the schematic.

2. Configure the Components as Table 9 lists. Connect the Components as Figure 71 shows.

Table 9. Component Configurations

Component Name Configuration
Digital Input Pin Pin_Button Drive Mode: Resistive Pull-Up
Interrupt: Rising-Edge
Digital Output Pin Pin_Clock Default Configuration
Digital Output Pin Pin_CtrIReg Default Configuration
Clock SYSCLK Source: SYSCLK
Interrupt isr_Buttton Default Configuration
Control Register Ctrl_Reg Output: 1
Initial value: 1

Figure 71. Avoiding Glitch While Exiting Deep-Sleep
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SW Pins
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SYSCLKE |
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3. Add the following code to the main.c file.

isr_Button

—1{m1 Pin_Clock

[ — +|m| Pin_CtrlIReg

{

/* The flag to enter ISR */
uint8 isrFlag
CY ISR(ISR Handle)

Ou;

/* Set FREEZE IO to 0x01 to avoid glitch by enabling the GPIO freeze */
/* else set it to 0 */
#define FREEZE IO 0x01
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/* Set the flag */
isrFlag = lu;

/* Clear pin interrupt */
Pin Button ClearInterrupt();
}

int main ()

{
/* This variable is used as backup for Control register value */
uint8 ctrlRegVal = Ou;

/* Clear the flag */
isrFlag = 0QOu;

/* Start the ISR */
isr Button StartEx (ISR Handle);

CyGlobalIntEnable;

/* Set Control register output as high */
Ctrl Reg Write(lu);

for(;;)
{
/* If freeze flag is set */
if(0u != isrFlag)
{
/* Clear isr flag set in GPIO Interrupt Handler */
isrFlag = Ou;

/* Rewrite the value */
Ctrl Reg Write(ctrlRegVal);

#if(FREEZE7IO)
/* Unfreeze I/0 */
CySysPmUnfreezeIol();
#endif
}

/* Delay 200us */
CyDelayUs (200u) ;

/* Store the value of Control register */
ctrlRegVal = Ctrl Reg Read();

#if(FREEZEiIO)
/* Freeze I/0 */
CySysPmFreezeIo() ;
#endif

/* Enter Deep-Sleep mode */
CySysPmDeepSleep () ;

To disable the freeze option, set FREEZE_|O to 0. Build and program the device. When the button is pressed and
released, the glitch can be seen on Pin_CtrIReg as Figure 72 shows. To enable the freeze option, set FREEZE_IO to
1. Build and program the device. In this case, I/O is frozen and no glitch is observed, as Figure 73 shows.
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Related Application Notes

AN79953 — Getting Started with PSoC 4

ANB86233 — PSoC 4 Low-Power Modes and Power Reduction Techniques

AN60024 — Switch Debouncer and Glitch Filter with PSoC 3, PSoC 4, and PSoC 5LP
AN72382 — Using PSoC 3 and PSoC 5LP GPIO Pins

AN90799 — PSoC 4 Interrupts

AN2094 — PSoC 1 Getting Started with GPIO

ANB89610 - PSoC® 4 and PSoC 5LP ARM Cortex Code Optimization

Summary

This application note explains the basic use cases of the GPIO modes in PSoC 4 using the Pin Component in PSoC
Creator.
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Appendix A: PSoC 4 GPIO Compared to PSoC 1, PSoC 3, and PSoC 5LP
GPIO

The PSoC 4 GPIO is different from that of PSoC 1, PSoC 3, and PSoC 5LP; see Table 10 for details.
Table 10. PSoC 4 GPIO versus PSoC 1, PSoC 3, and PSoC 5LP GPIO

GPIO Features PSoC 1 PSoC 3 PSoC 4 PSoC 5LP
CapSense ~ N N N
LCD segment drive v N NG \
Eight drive modes v N N N
POR state configuration X J X \
Separate port DR and PS X N N N
Input/output synchronization X Bus_clk HFCLK, External* Bus_clk

* Not available in PSoC 4000

B Appendix B: PSoC 4 Development Boards

You can test the PSoC Creator projects provided with this application note on the following Cypress development

boards.
Device Family Development Board
PSoC 4000 CY8CKIT-040 PSoC 4000 Pioneer Development Kit
PS0C 4200 / PSoC 4100 CY8CKIT-042 PSoC® 4 Pioneer Kit
PSoC 4 CY8CKIT-049 4xxx Prototyping Kits
PSoC 42x7_BL CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit
PSoC 4200M CY8CKIT-044 PSoC® 4 M-Series Pioneer Kit
PSoC 4200L CY8CKIT-046 PSOC® 4 L-Series Pioneer Kit
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